Prosthetics Patch RMPR*3*59


Version 3.0

June 2003

Department of Veterans Affairs
Health System Design and Development (HSD&D)
# Table of Contents

**Automated Delayed Order Report (DOR) User Manual** .......................................................... 1
  Overview ......................................................................................................................................... 1

**Display the DOR Data** .............................................................................................................. 3
  Introduction ................................................................................................................................. 3
  Select a Site(s) ........................................................................................................................... 4
  Select a Starting Date .................................................................................................................. 5
  Select a Status ............................................................................................................................. 6
  Select the SSN Range .................................................................................................................. 7
  Display the Data .......................................................................................................................... 8
  View DOR Calculation Detail ..................................................................................................... 10
  View Pending Calculations ....................................................................................................... 14

**View 2319 Information** .......................................................................................................... 15
  View 2319 – Patient Demographics .......................................................................................... 15
  View 2319 - Clinic Enrollments/Correspondence ...................................................................... 16
  View 2319 - Entitlement Information ......................................................................................... 17
  View 2319 – Appliance Transactions .......................................................................................... 18
  View 2319 – Auto Adaptive Info ............................................................................................... 20
  View 2319 - Critical Comments ............................................................................................... 21
  View 2319 – View HISA Information ....................................................................................... 22
  View 2319 – Home Oxygen ....................................................................................................... 23

**View and Manage the DOR** ..................................................................................................... 25
  View CPRS .................................................................................................................................... 25
  View Request ............................................................................................................................... 26
  Save as an Excel File .................................................................................................................... 27
  Print the DOR ............................................................................................................................... 28

**Appendix A** ............................................................................................................................... 29
  Using the Menus .......................................................................................................................... 29

**Appendix B** .................................................................................................................................. 30
  Getting Help .................................................................................................................................. 30
  Activate Section 508 Assistance ............................................................................................... 31
Introduction

The Delayed Order Report (DOR) User Manual corresponds to Patch RMPR*3*59. This patch provides Prosthetics GUI (graphical user interface) windows for the Delayed Order Report (DOR) feature.

Note: Using this feature requires basic MS Windows skills.

The Prosthetics users will be able to do the following with this patch:

- Search for and display manual suspense entries/electronic consult (CPRS order) data by one or all sites.
- Display data using one or multiple statuses (Open, Pending, Cancelled or Closed).
- Use a starting date for Closed and Cancelled records to display data.
- Sort and rearrange the view; display data in a custom view.
- Print the display.
- Convert the display into a Microsoft Excel file (for more sorting capabilities).

Working Days

A delayed order is counted in Working days not Calendar days. This does NOT include Saturdays and Sundays or Holidays!!!
Overview, Continued

---

**Status cycle**

The *Initial Action Date* displays the date of the first action taken on the suspense entry/electronic consult (CPRS order) record. This changes the status from OPEN to PENDING. An order remains in PENDING status until it is fulfilled and then changes to a CLOSED status.

**Note:** The status can change from OPEN to CLOSED if the order has been fulfilled upon the initial action.

Keep in mind that when creating the first action note, the status changes from OPEN to PENDING and when creating the second or additional action note(s), the status remains PENDING. Only when a record is completed does the status change to CLOSED.

When a complete note is posted, all action has taken place for a requested Prosthetic item or service. When you post the complete note, the status on the record changes from PENDING (if action has previously taken place on the request) or OPEN to a CLOSED status.

---

**Work Days, not Calendar Days**

The *Delayed Order Report* displays the number of “Work” days (not Calendar days) from the original date the order was entered as an electronic consult or a suspense entry to the day it is completed. A “Work” day is defined as Monday through Friday.

**Note:** The calculation subtracts Saturdays and Sundays and Holidays from the number of days the order was entered, even if a CPRS order was written over a weekend. *Holidays are NOT counted.*
Display the DOR Data

Introduction

General steps to view DOR Data

To utilize the Delayed Order Report (DOR) data, here is a general set of steps to display DOR data as follows:

1. Select ALL sites by checking the “Or… All Sites” checkbox (or you can select a specific site from the drop down list).
2. Enter a Starting Date (defaults to the current date).
3. Select a Status if you want to change the default statuses. The default statuses are set to Open, Pending, and Closed.
4. Enter the SSN range of the patient display (mandatory).
5. Click the Display button.

Description

The Description is a free-text field that is manually entered with approximately 15 characters in length. If you can’t view the entire description, you can expand the column by clicking and dragging the borderline to a wider position.

Data displayed

The data that is displayed with this GUI feature includes the following:

Grid Columns:
- Site
- Delayed column (Yes or No)
- Status of the order
- Type of Order – Manual Suspense or Routine (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders)
- Station number
- Create Date (Suspense entry date)
- First Action Date – Date that the order was put into PENDING status
- Number of Days that the order has been delayed including columns for: 0-5, 6-9, 10-29, 30-90, and 90+ columns
- Link information – linked message(s) to the order record
- Brief description
- Patient name
- Social Security Number

Fields:
- Selection Result Totals (near bottom of window) include:
  - Total records found
  - Total delayed records by calculation
  - Percent delayed records by calculation
Select a Site(s)

Select Site

The first thing you must do to view the DOR is to select a site for the records that you want to display. If you are a multi-site facility, you will be able to select the specific site you want to view via the drop down box. Recommendation: It is highly recommended that you select the “Or…All Sites” checkbox.

Steps

To begin the process to display the DOR data, follow this first step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the “Or…All Sites” checkbox to view ALL sites and CBOC data.</td>
</tr>
</tbody>
</table>

DOR window

If you want to view all available suspense entries/electronic consult orders including Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox instead of selecting your specific site from the Site drop-down list box. This ensures that the display will include all sites. For example, the Kenoshia, Wisconsin CBOC will not display when the Milwaukee site is selected only. These records display when the All Sites checkbox is selected.
Select a Starting Date

**Date/Calendar**
Note the *Starting Date* defaults to the current date. You can change this date. Enter a *Starting Date* by clicking on the drop-down list box. A calendar displays with the current date circled in red and shown at the bottom of the calendar. You can accept the current date by clicking on it.

**Steps**
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Enter a Starting Date (defaults to the current date).</td>
</tr>
</tbody>
</table>

**Date**
You can change the date by the following methods:

<table>
<thead>
<tr>
<th>Change the...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>Click on the actual day of the week in the calendar.</td>
</tr>
<tr>
<td>Month</td>
<td>Click on the month at the top of the calendar to display a list of all months and select one. Or you can decrease or increase one month at a time by clicking the left or right arrows.</td>
</tr>
<tr>
<td>Year</td>
<td>Click on the year and an up and down arrow button displays for you to increase or decrease the year.</td>
</tr>
</tbody>
</table>
Select a Status

**Status**
You can view **Open**, **Pending**, **Closed** or **Canceled** records by clicking the checkbox for one or all of these options. The default statuses that are already checked are: **Open**, **Pending** and **Closed**. You can click in these boxes to uncheck any status.

**Steps**
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Select a Status if you want to change the default statuses.</td>
</tr>
</tbody>
</table>

**Status Scenarios**
There are a number of combinations that you can choose including the following status scenarios:

**Scenario 1:** If you select the **Open** and **Pending** statuses, you will view all suspense records/electronic consult records (CPRS orders) available with a status of **Open** and **Pending**.

**Scenario 2:** The **Starting Date** field works with the **Closed** and **Canceled** statuses. If you check either one of these statuses, you can then select the **Starting Date** to display these records. (The **Starting Date** field that you select plus **Closed** Delayed records for that period does NOT affect the **Open** and **Pending** status record display.)

**Scenario 3:** If you select all four statuses, you will view ALL **Open** and **Pending** records. You will also view the **Closed** and **Canceled** records beginning with the **Starting Date** you select ONLY.
Select the SSN Range

SSN fields
You must have an SSN range to view DOR data. There is a Starting SSN and an Ending SSN field box. This is a range of patient Social Security Numbers by the last two digits. When you enter a range, it will display electronic consults or manual suspense entries within that range.

If your workload is categorized by the SSN for a specific Purchasing Agent, then you can display entries that are assigned by one Purchasing Agent at a time.

Note: Enter a range of 00 to 99 to view all Purchasing Agents’ SSNs for all patients.

Steps
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Enter the SSN range of the patient display (mandatory).</td>
</tr>
</tbody>
</table>

SSN range

[Image of Delayed Order Report interface]

Press to DISPLAY the requested data
Display the Data

Data display
The data displayed are manual suspense and all other consult entries. You’ll notice columns with a breakdown of days of 0-5, 6-9, 10-29, 30-89 and 90+ columns.

These columns display the total number of days old by category within the breakdown of the columns. It does NOT display the total number of instances of records (manual suspense entries or electronic consults via CPRS orders).

Steps
To continue to display the DOR data, follow this step:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Once you have the desired criteria, click the <strong>Display</strong> button. (You can also double click a record to view the <strong>Request</strong> window.) <strong>Shortcut:</strong> Press the <strong>&lt;Alt&gt;</strong> key + <strong>&lt;D&gt;</strong> key.</td>
</tr>
</tbody>
</table>

Sizing and Sorting columns
Columns are sizable on this window, but not movable. To resize a column, you can place the cursor on the column header borderline until you can view the double-headed arrow. Then click and drag the column until it is the size you want.

To sort the columns, click the column header and the data will redisplay in ascending or descending order. **Note:** Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

Delayed Order Report window
Continued on next page
Display the Data, Continued

Menu, Refresh and Clear buttons

The Menu button returns you to the Prosthetics Main Menu window where you can open additional applications at the same time. The Refresh button resets (recalls) the data if you had made some column sizing changes. It is the same as clicking the Display button again. You can use the Clear button to blank out the window and start over with new display criteria.

Column titles

Below are the header titles of each column and a description of each.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dlyd</td>
<td>The Delayed column will display either a Yes or No as to whether the record is delayed or not. You can sort on this column by all “Yes” records or all “No” records by clicking on the column.</td>
</tr>
<tr>
<td>Status</td>
<td>The Status of the record is either Open, Pending, Closed or Cancelled. Records with an Open status are shown in blue.</td>
</tr>
<tr>
<td>Type</td>
<td>This is the Type of record - Manual Suspense entry or Routine Consult (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders).</td>
</tr>
<tr>
<td>Station</td>
<td>This is the Station Identifying number.</td>
</tr>
<tr>
<td>Create</td>
<td>The Create date is the date that the record was created.</td>
</tr>
<tr>
<td>1st Action</td>
<td>The First Action date is the date that initial action was taken on the request and the status changed from Open to Pending.</td>
</tr>
<tr>
<td>0-5</td>
<td>The number of days (0-5) that an order record is not delayed.</td>
</tr>
<tr>
<td>6-9; 10-29; 30-89; 90+</td>
<td>These columns of number ranges designate the number of Workdays within these ranges that a request has been delayed. This does NOT include Saturdays and Sundays nor Holidays. This also designates that the record is in a Pending status. Any record over 5 days is highlighted in red with yellow numbers. Note: The numbers listed in each row for a record designate the number of days NOT the number of record instances.</td>
</tr>
<tr>
<td>Lnk</td>
<td>The Link column designates how many items that were linked to that record. It could be a zero or a number. Note that if the status is Closed, and there is a zero in the Link column, then those records were never linked.</td>
</tr>
<tr>
<td>Description</td>
<td>This is the description of the request.</td>
</tr>
<tr>
<td>Patient</td>
<td>The patient name is displayed.</td>
</tr>
<tr>
<td>SSN</td>
<td>The Social Security Number for the patient is displayed.</td>
</tr>
</tbody>
</table>

Yellow and Red fields

Records that have a delayed date beyond 5 days will have the number of days in yellow and the block will be highlighted in red.

Records with 0-5 days will have the number shown in bold print.
**View DOR Calculation Detail**

**DOR Detail button**
You can view the DOR calculation detail for the range of consults and manual suspense entries that you displayed. When you select the **DOR Detail** button, it doesn’t matter what status is checked because the calculation looks at all the **Open**, **Pending** and **Closed** records from the starting date you selected.

**Number of MANUALS**
You can view the total number of **Manual** suspense entries that are in **Open**, **Pending** or **Closed** status. Those in the 6-9 or higher columns show the ones that are Delayed.

**Number of CONSULTS**
You can view the total number of electronic Consults (that were not entered manually) that are in **Open**, **Pending** or **Closed** status and have not had any action taken on them. Those in the 6-9 or higher columns show the ones that are Delayed.

**SUB TOTAL**
The **SUB TOTAL** row totals the number of **Manual** suspense entries + the total number of all other consults.

**DOR Calculation Detail window**

**Minus PENDING**
This row displays the number of consults that have had an initial action taken on it (starting with the date you selected in the calendar for the starting date which is shown here by 1/1/2003) and put into a **Pending** status.

This number is subtracted from the subtotal for the **Total Delayed** row below that.

*Continued on next page*
The **TOTAL DELAYED** is calculation that adds the total number of *Manual Suspense* records + the total number of all other consults and subtracts the number of consults in a *Pending* status (Pending from before the Start Date selected).

The **Total of Sub Total** field includes: 1) the total from the **Sub Total** above (third row), 2) all totals of *Manual Suspense* entries and 3) all other electronic consults.

The next row shows the calculation for the Total consults minus the *Pending* consults from the starting date that you selected.

The **TOTAL DELAYED** field is shown.

This displays the Total Delayed from the grid above (any greater than 5 days delayed) divided by (the result of the total Sub Total minus Total Pending as of 1/1/03) and multiplied by 100. This is the percentage delayed.

The final calculations above, this equals the **Percent Delayed** (shown as 95.37%).

Continued on next page
The scenarios below describe different timelines when orders are received at different times of the month and if they are delayed. Then it will explain which month’s Calculation Report where the data will appear.

Scenario 1
An order is received on Tuesday, June 3rd and is changed to Pending or Closed status on Friday, 6/6. This is not a delayed order and would appear in the June Calculation Report as an order received.

Scenario 2
An order is received on Tuesday, 6/3 and is changed to Pending or Closed on Wednesday, 6/20. This is a delayed order and would be included in the June Calculation Report as a delayed order.

Scenario 3
An order is received on Thursday, 6/26 and is changed to Pending or Closed on Tuesday, 7/15. This was not a delayed order in June; however the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would also be included in the July report as a delayed order and would be included in the calculations.

Scenario 4
An order is received on Thursday, 6/26 and changed to Pending or Closed on Monday, August 4th. This is not a delayed order in June; however, the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would be included in both the July and August report as a delayed order and would also be included in the calculations.
Print button

You can print the DOR Calculation Detail data by clicking the Print button. A Print Preview pane will display that allows you to zoom in, scroll forward/backward, print, save the data, or open/load a new report.

Click the Close button to return to the DOR Calculation Detail window.

Print Preview

![Print Preview Image]

View DOR Calculation Detail, Continued
View Pending Calculations

Pending Calc Button
Click on the **Pending Calc** button on the DOR window and the window displays based on the selection criteria of this window.

Pending status consults
The **Pending Calculations** window displays the total number of Workdays with the total number of **Pending** records since an initial action was taken on it. These records are categorized into columns by the number of Workdays it has remained in a **Pending** status.

The calculation used to display these **Pending** status records is from the **First Action date** (not from **Creation Date**) to the **current date**. This is a tool to help managers monitor their consults and manual suspense entries that have been **Pending** for an extended period of time.

Pending Calculations

![Pending Calculations Table]

<table>
<thead>
<tr>
<th>Station</th>
<th>1st Action</th>
<th>Speed 0</th>
<th>Speed 29</th>
<th>Speed 89</th>
<th>Speed 90</th>
<th>Speed 91</th>
<th>Speed 92</th>
<th>Speed 93</th>
<th>Description</th>
<th>Status</th>
<th>COST</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>DESCRIPTION OF APPLIAN</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>550</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>02/25/2002</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>768</td>
<td></td>
<td></td>
<td></td>
<td>TESTING PCE</td>
<td>PRINT 000.</td>
<td></td>
</tr>
</tbody>
</table>

**Print button**
The **Print** button allows you to print the Pending Action Calculations and will display the **Print** dialog box.

**Excel button**
You can send this data to MS Excel by clicking the **Excel** button. It will launch the application and display the data at the same time.

**Close button**
To exit, click the **Close** button or the **X** button in the top right-hand corner.
# View 2319 Information

## View 2319 – Patient Demographics

### Introduction

The **View 2319** button displays the 10-2319 Prosthetic patient records. The title bar displays the patient name and SSN. Here are the windows of information that you can view from the patient’s 2319:

1. Patient Demographics
2. Clinic Enrollments/Correspondence
3. Entitlement Info
4. Appliance Transactions
5. Auto Adaptive Info
6. Critical Comments
7. HISA Information
8. Home Oxygen Items

**Note:** Use the `<Alt>` key and the number to toggle to different tabs.

### Demographics data

You can view the patient demographics for the veteran. This includes: Name (in red if deceased with Date of Death listed above the Date of Birth and the age field will not display), address, next of kin, emergency contact information, veteran benefits and eligibility (former Prisoner of War (highlighted in blue if “Yes”), Aid & Attendance, service connected, non-service connected, etc.).

### 1. Patient Demographics window

<table>
<thead>
<tr>
<th>PROSPATIENT, ONE</th>
<th>Benefits &amp; Eligibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date of Death: SEP 2, 2006</td>
<td>Date of Birth: 1/3/36</td>
</tr>
<tr>
<td>Address: 255 NY ST</td>
<td>DOB: Nov 14, 1936</td>
</tr>
<tr>
<td>City: BATTLE CREEK</td>
<td>Sex: MALE</td>
</tr>
<tr>
<td>State: MICHIGAN</td>
<td>Race: WHITE</td>
</tr>
<tr>
<td>Zip: 49017</td>
<td>Religion: BAPTIST</td>
</tr>
<tr>
<td>Phone: 555-5555</td>
<td>Mental Status: MARRIED</td>
</tr>
<tr>
<td>County: CALHOUN</td>
<td>Social Security #: 123-45-6789</td>
</tr>
</tbody>
</table>

**Next of Kin**

- **Name:** FATHER
- **Address:** 255 NY ST
- **City:** BATTLE CREEK
- **State:** MICHIGAN
- **Zip:** 49017
- **Phone:** 555-5555
- **Relation:** MOTHER

**Emergency Contact**

- **Name:** MOTHER
- **Address:** 255 NY ST
- **City:** BATTLE CREEK
- **State:** MICHIGAN
- **Zip:** 49017
- **Phone:** 555-5555
- **Relation:** SISTER

June 2003


Patch RMPR*3*59
View 2319 - Clinic Enrollments/Correspondence

Window description
This second tab details clinic enrollments and correspondence for the veteran. This includes the following: the last movement actions (i.e., hospital admissions and discharges), clinic enrollments, pending appointments and correspondence letters.

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

2. Clinic Enrollments/Correspondence

Exit
To exit, click the Close button or the button in the top right-hand corner.
View 2319 - Entitlement Information

**Window description**
The third tab details entitlement and loan information for the veteran. This includes the following: PSC Issue Card, clothing allowance, items on loan, and items returned.

**3. Entitlement Info**

![Entitlement Info Window]

*Not available in this version*

**Exit**

To exit, click the **Close** button or the button in the top right-hand corner.
View 2319 – Appliance Transactions

Appliance Transactions

The **Appliance Transactions** tab of the View 2319 window displays all transaction history for a veteran. The **Date** column is the date of the PO. Columns are re-sizeable on this window (not movable). The total records found displays at the bottom.

**Note:** Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

Steps

To view the Appliance Transactions detail, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>View Detail</strong> button below to display the appliance details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

![Image of View 2319 window with Appliance Transactions tab open]

Exit

To exit, click the **Close** button or the **X** button in the top right-hand corner.

*Continued on next page*
Steps

To continue to view the Appliance Transactions detail, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>The <strong>Transaction Detail</strong> window is shown below.</td>
</tr>
<tr>
<td>4</td>
<td>Click the Close button to return to the <strong>Appliance Transaction</strong> window.</td>
</tr>
</tbody>
</table>

Appliance Transaction Detail

Exit

To exit, click the **Close** button or the button in the top right-hand corner.
View 2319 – Auto Adaptive Info

Window description

The fifth tab details the Auto Adaptive information.

5. Auto Adaptive Info

![Not available in this version]

Exit

To exit, click the **Close** button or the button in the top right-hand corner.
View 2319 - Critical Comments

Window description

The sixth tab details any critical comments recorded for the veteran.

6. Critical Comments

Exit

To exit, click the Close button or the button in the top right-hand corner.
View 2319 – View HISA Information

Window description

The seventh tab details the HISA (Home Improvement Structural Alteration) information including the date, quantity, item, type, vendor, station number, serial, HCPCS Code and cost of the item ordered.

Note: “HISA Information” is the new name for this window; it used to be “Add/Edit Disability Codes.”

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the View Detail button below to display the HISA information details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

7. HISA Information

To exit, click the Close button or the button in the top right-hand corner.
View 2319 – Home Oxygen

Window description

The eighth tab details the **Home Oxygen** information including the date, quantity, item, type, vendor, station, serial, HCPCS Code, and total cost of the item(s).

**Note:** Due to some records not having a 1\(^{st}\) Action date, sorting by this column will not sort in date order.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select a transaction by clicking on it to highlight it.</td>
</tr>
<tr>
<td>2</td>
<td>Click the <strong>View Detail</strong> button below to display the Home Oxygen information details. (You can also double click a record to view the details.)</td>
</tr>
</tbody>
</table>

8. Home Oxygen

<table>
<thead>
<tr>
<th>Date</th>
<th>Qty</th>
<th>Item</th>
<th>Type</th>
<th>Vendor</th>
<th>Station</th>
<th>Serial</th>
<th>HCPCS</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/01/00</td>
<td>1</td>
<td>EYESGLASS</td>
<td>VENDOR EIGHT</td>
<td>100</td>
<td>A10000</td>
<td>56.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/00</td>
<td>1</td>
<td>EYESGLASS</td>
<td>VENDOR ELEVEN</td>
<td>499</td>
<td>B1200</td>
<td>56.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/00</td>
<td>1</td>
<td>EYESGLASS</td>
<td>VENDOR ELEVEN</td>
<td>499</td>
<td>B1200</td>
<td>56.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/00</td>
<td>1</td>
<td>EYESGLASS</td>
<td>VENDOR ELEVEN</td>
<td>499</td>
<td>B1200</td>
<td>56.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>03/01/00</td>
<td>1</td>
<td>EYESGLASS</td>
<td>VENDOR ELEVEN</td>
<td>499</td>
<td>B1200</td>
<td>56.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Exit

To exit, click the **Close** button or the button in the top right-hand corner.

View Detail

When you select a record and click the **View Detail** button, the following window displays as shown on the next page

Continued on next page
View 2319 – Home Oxygen, Continued

View Detail button

After clicking the View Detail button on the Home Oxygen window, the following window displays for the patient.

Transaction Detail window

Close button

To exit, click the Close button or the button in the top right-hand corner.
View and Manage the DOR

View CPRS

Function description

The View CPRS button from the DOR window allows you to view all the consult data on the View CPRS window as shown below. This is the same data as in the electronic Consult - Suspense (SU) Menu feature where you can enter CD for the CPRS Display.

View CPRS window

To exit, click the Close button or the button in the top right-hand corner.
**View Request**

**Function description**
When you click the **View Request** button on the DOR window, the **View Request** window displays as shown below. This provides the display of the manual suspense entry for the patient.

**Note:** You can also double click on a record in the DOR window grid to display this **View Request** window.

**View Request window**

![View Request window](image)

**Close button**
To exit, click the Close button or the button in the top right-hand corner.
Save as an Excel File

Excel Button

The Excel button on the DOR window will automatically launch the Microsoft Excel software program for you. It converts the data that you have selected to display into the Excel file as shown below.

Shortcut: Press the <Alt> key + <X> key.

This feature creates a temporary Excel .CSV file in the C:\NPPDDownLoad folder where the file is temporarily held. The file name is based on the site + the beginning and ending range of the patient’s SSN. You can save this as an Excel file using the Save As option from the File Menu. When you exit the Prosthetics Main Menu window (VISTA suite), the .CSV file will be deleted.

Example: The DOR_9_50_60.csv filename includes the Site ID # or “ALL” and SSN range.

MS Excel data

You can now use any of the features of Microsoft Excel to manipulate your data. Notice that you may need to scroll to the right to view all of the columns.

Print the data

You can also print the data from Microsoft Excel. Click the File Menu and the Print option. See next page for more printing information.

June 2003
Print the DOR

Print the DOR data
You can print the DOR data using the Print button to send this data to your local printer. You can also click the File Menu and the Print-Request Grid option, and the Print dialog box displays. The layout of the print will be the same as the display.

Shortcut: Press the <Alt> key + <P> key.

Note: You can select a different printer that you have setup to print the detail.

Landscape default
When printing grids, the default is set to print in the Landscape format and then returns the printer to the prior state.

Steps
To print the DOR, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Print button on the DOR window.</td>
</tr>
<tr>
<td>2</td>
<td>The Print dialog box displays.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Properties button (to the right of the Name field) on the Print dialog box if you want to change the page orientation of the printout. (Optional)</td>
</tr>
<tr>
<td>4</td>
<td>Click the OK button.</td>
</tr>
</tbody>
</table>

Print dialog box
![Print dialog box image]
Appendix A

Using the Menus

Menus
Below are the different menus and menu options that are available to be used instead of the corresponding buttons. You can use these menu options alternatively.

The Help Menu is the only menu that does not have a corresponding button. This menu leads you to online help through the Contents option. The Section 508 option is described more in Appendix B.

File Menu

Select and Display Menu

View Menu

Help Menu
Appendix B

Getting Help

F1 Key

Online Help can be accessed in three methods:

1. Click the **Help** Menu (located in the upper left corner of the menu bar) and the **Contents** option.
2. Press the **<F1>** key.
3. Press the **<Alt>** key + **<H>** key. (This activates the **Help** Menu, not the DOR contents.)

Help Menu
Activate Section 508 Assistance

Introduction
You can change the colors of the screen to black/white, which is required for Section 508 requirements to be read by visually and hearing impaired veterans.

This feature can be updated from the Help Menu. It provides a toggle to go back and forth between using the colors or the black/white screens depending on your needs.

Steps
To activate the Section 508 assistance, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click the Help Menu, and click the Section 508 option.</td>
</tr>
<tr>
<td>2</td>
<td>Click OK on the confirmation message dialog box as shown below.</td>
</tr>
<tr>
<td>3</td>
<td>Click OK again to exit out of the system and restart to activate the changes.</td>
</tr>
</tbody>
</table>

Confirmation message
[Image of confirmation message]

Exit/Restart message
[Image of exit/restart message]